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Overview 

The LEDBlinky Animation Editor allows you to create and edit LED animations for 
use with the LEDBlinky Arcade LED Control Software. Use the WYSIWYG 
interface to build a virtual representation of your control panel. With your actual 
control panel actively connected to the PC, the animation editor will light both the 
virtual and real LEDs as you edit the animation. Animations can be tested in real-
time; as they will appear when using the LEDBlinky application. Each LED can 
be turned on or off, faded up or down, or color transitioned (from color A to color 
B). Groups of frames can be repeated. 
 
See Appendix A for a list of supported LED controllers. 
 

LEDBlinky Website 

For software updates and online support, please visit the LEDBlinky website. I 
have also documented the software development, along with my MAME project 
and other arcade related stuff on my Arcade Addiction site.  
 

Installation 

The LEDBlinky Animation Editor is included and installed with the LEDBlinky 
application. All files should exist within the LEDBlinky folder. If you are using the 
LEDBlinky Animation Editor as a stand-alone application, unzip the files into any 
folder. 
 
…\Plugins 

  …\Plugins\LEDBlinky 

  Animation Editor.pdf 

  GenLEDBlinkyInputMap.exe 

  HowlerDLL.dll 

  LEDBlinkyAnimationEditor.ini 

  LEDBlinkyAnimationEditor.exe 

  Ledwiz.dll 

  PacDrive32.dll 

 

http://www.ledblinky.net/
http://www.arcadeaddiction.net/
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How Do I Get This Thing To Work? 

 
Step 1 

 Before you can use the LEDBlinky Animation Editor, you must first define the 
LED controller Input Map. If you’re currently using the LEDBlinky LED Control 
software, then you may already have this file (LEDBlinkyInputMap.xml) and you 
can skip to Step 2. Otherwise, run the Generate LEDBlinky Input Map application 
(GenLEDBlinkyInputMap.exe). 
 
The input map defines each wired port on your LED controller(s) with a Port 
Label and LED Type. The Port Labels serve two purposes, they tie together three 
ports for RGB LEDs, and they provide an easy reference to the ports on the 
virtual control panel layout. The LED Type defines LEDs as Single, Red, Green, 
or Blue. 
 
Note: For the animation editor, Input Codes are not required. If you are not using 
the LEDBlinky application or plug-in, you do not need to define the input codes 
for each port. 
 
For example; let’s say LED controller ports 1, 2, and 3 are wired to an RGB LED 
under a button. That button is wired to the keyboard encoder and assigned to the 
letter “A”. We also have an LED under our TrackBall wired to port 4. The input 
map would have four entries: 
 

Using LEDBlinky 

 
 

Not using LEDBlinky 

 
 

A full description on how to use this application is provided in the LEDBlinky 
Installation and Configuration Guide (Install and Config.pdf). 
 
Step 2 

 Run the LEDBlinky Animation Editor. The editor has two basic modes; Layout 
and Animation. Use Layout Mode to create a virtual representation of your 
control panel. From the Layout menu, select New. You will be prompted to select 
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the Input Map file created from the prior step, after which the LED panel will be 
populated with the defined LEDs.  
 
Using the mouse or arrow keys, move the LEDs to match your control panel 
layout.  To select a single LED, left-click with the mouse. To select or deselect 
multiple LEDs, hold the ctrl key while left-clicking with the mouse. You can also 
select multiple LEDs at one time by dragging a bounding box with the mouse. 
Hold the crtl key to retain previously selected LEDs. 
 
Right-click on each LED to define the LED Off color (from the Color Sample Box) 
and LED Size. The LED Off color should match the actual LED colors - for 
example, Electric Ice Buttons are pearl white. From the Layout menu, you can 
specify other global layout options such as the control panel color, LED border 
color, LED label color, and LED Label size. 
 
New Layout 

 
 
My Control Panel  

 
 
When you’re layout is complete, select Save from the Layout menu. 
 
Step 3 

 From the Edit menu, switch to Animation mode. LED Animations consist of 
individual frames. Each frame defines the intensity (for Single LEDs) or color (for 
RGB LEDs) and the on/off state for each LED. In animation mode, the LED 
labels switch to intensity values (0-48). 
 
LEDs in the Off state are represented with a diagonal hash pattern in the “off” 
color specified during the layout design.  
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In this example four LEDs are ON (red, yellow, orange, and blue). The rest are OFF. 

 
 
A new animation starts with a single frame with all LEDs off and set to zero (0) 
intensity values. Start by setting the intensity and/or color values for each LED. 
Use the sliders or Pick Color button to set the Color Sample Box. Any currently 
selected LEDs will change intensity/color as the slider values are set. If your 
control panel is connected to the pc, the actual LEDs will also change 
intensity/color. You can also select LEDs (using methods discussed in Step 2) 
and then click the Color Sample Box to set the values. Setting the intensity/color 
for an LED will change it to the On state. Double-click on an LED to toggle 
between On and Off.  
 
Note: For LED controllers that do not support intensity values, the initial intensity 
value will be 48. 
 
Color/Intensity Controls 

 
Note: for Single Type LEDs, only the Intensity slider applies. 

 
Tip: Right-click on an LED and select Get LED Color/Intensity to set the Color 
Sample to the current LED color/intensity. The Get and Set LED Color/Intensity 
menu options can be used as a copy/paste feature. 
 
A note on visualizing color intensities: Reducing an LED intensity (dimming) will 
cause the color to turn toward black on the virtual control panel. Low intensity 
values are not easily distinguished on the virtual control panel – use your actual 
control panel to visualize these colors. 
 
Continue creating your LED animation using the frame editing buttons. New 
frames (inserted or added) will always inherit the intensity and on/off values from 
the prior frame. The duration for each frame (in milliseconds) can be set 
independently or you can set the duration for all frames from the Edit menu. 
Groups of frames can be repeated using the Goto and Repeat fields. 
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Frame Editing Controls 

 
 
Tip: The LED-Wiz hardware can set the LED state (on or off) faster than it can 
set the LED intensity value. For smoother animations, you should set the LED 
intensities as few times as possible. For example, let’s say you want to sequence 
your RGB LEDs in all blue and then in mixed static colors. In the first frame, set 
all LEDs to blue and then only toggle their on/off state in each frame to create the 
blue sequence pattern. When the blue sequence is complete, set each LED to its 
new color and then only toggle the on/off state in each frame to create the next 
sequence pattern. 
 
As your animation progresses, use the Frame controls to move forward or 
backward. Use the Frame slider to select the current frame or to simulate the 
animation. To run the animation in real-time; use the Run menu or the Run LED 
Animation  or Run Virtual Animation  buttons. When your animation is 
complete, select Save from the Animation menu. 
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Functions and Features  

 

Menus  

 
 
Layout – New 
Displays a file dialog to select the Input Map and then loads a new set of LEDs 
based on the wired ports. If the current layout has been modified, you will be 
given the option to save prior to starting a new layout. 
 
Layout – Open 
Displays a file dialog to select and load an existing layout file. Layout files have a 
.LAY extension. If the current layout has been modified, you will be given the 
option to save prior to selecting a different layout. 
 
Layout – LED Controller Independent 
Loads a new set of LEDs for creating controller independent (generic) 
animations. Use this option is you wish to create animations which can be shared 
with other systems. If the current layout has been modified, you will be given the 
option to save prior to creating an LED controller independent layout. 
 
LED Controller Independent animations will run on all compatible LED controllers 
for use with any system regardless of the LED configuration or layout. The LED 
Controller Independent layout will include a single instance of each compatible 
LED controller (controller ID1) with a single LED for each port. Multiple additional 
controllers (ID2, ID3, ID4, etc.) of the same type, although not displayed in the 
layout, will all run the animation identically.  
 
It is not possible to create a controller independent animation that varies between 
LED controllers or groups RGB LED ports. RGB buttons will light up as three 
individual LEDs. 
 
Layout – Save 
Saves the current layout.  
 
Layout – Save As 
Displays a file dialog to save the current layout file. Layout files have a .LAY 
extension.  
 
Layout – Layout Options 
Displays the Layout Options window. The layout options allow you to specify the 
Control Panel Color, LED Border Color, LED Label Color, and LED Label Font 
Size. 
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You can also define the Default On Behavior for Uninitialized LEDs. Turning On 
(double-clicking) an LED which does not yet have a color or intensity assigned 
can be handled one of three ways; “Do Nothing” will leave the LED as is with no 
indication if the LED is On or Off. “Use Current Color” will set the LED color to the 
currently selected value. And “Select Default” will allow you to define a default On 
color. 
 

 
 
Animation – New 
Start a new animation with a single frame, all LEDs off, and intensity values set 
to zero (0). If the current animation has been modified, you will be given the 
option to save prior to starting a new animation. 
 
Animation – Open 
Displays a file dialog to select and load an existing animation file. Animation files 
have a .LWAX. You can also open animations which use the LWA format, but 
they will be converted and saved in the LWAX format. If the current animation 
has been modified, you will be given the option to save prior to selecting a 
different animation. 
 
Animation – Save 
Saves the current animation. Animation files can only be saved in the .LWAX 
format. 
 
Animation – Save As 
Displays a file dialog to save the current animation file. Animation files can only 
be saved in the .LWAX format.  
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Animation – Import – Insert 
Import another animation file, inserting it in the current animation file after the 
current frame. A message will be displayed if the two animations are not 
compatible due to nested Goto/Repeat loops and provide the option to remove 
the loop(s) from the imported animation. 
 
Animation – Import – Overlay with Parent Priority 
Import another animation file, overlaying it in the current animation file starting 
with the current frame. 
 
When overlaying with Parent Priority, LED state and intensity will only be 
imported if the corresponding LED in the current (parent) animation is OFF. 
Duration and Goto/Repeat loops will not be imported. 
 
Animation – Import – Overlay with Import Priority 
Import another animation file, overlaying it in the current animation file starting 
with the current frame. A message will be displayed if the two animations are not 
compatible due to nested Goto/Repeat loops and provide the option to remove 
the loop(s) from the imported animation. 
 
When overlaying with Import Priority, All LEDs in an ON state will be imported, 
overwriting the corresponding LEDs in the current (parent) animation. The 
imported frame Duration will overwrite the corresponding frame Duration in the 
current (parent) animation. 
 
View – Show LED Values 
View – Show LED Name 
View – Hide LED Labels 
Show or hide the LED labels under each LED. In Layout Mode, the LED labels 
display the LED names as defined in the Input Map file. In Animation Mode, the 
LED labels can display the intensity value(s) or LED names as defined in the 
Input Map file. 
 
View – Show Frame XML 
Displays the Frame XML window. The Frame XML window displays the output 
xml for a single frame. This window can remain open while editing an animation. 
The xml will be updated as you make changes to the animation or change 
frames. 
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A note about animation optimization; When displaying the xml for an individual 
frame, both the Intensity and State values are listed for each LED controller. 
When the animation is saved to a .LWAX file, the Intensity values are optimized – 
they are only included for a frame if the values differ from the prior frame. 
 
View – Show Animation Overview 
Displays the Animation Overview window. The Animation Overview is a grid 
representation of the entire animation. Each row represents an LED and each 
column represents a Frame. Clicking on any cell will move the animation to the 
that frame and select the LED. This window can remain open while editing an 
animation. The overview will be updated as you make changes to the animation 
or change frames. 
 

 
 
View – Display 640 x 480 
Resize application window to fit on a 640 x 480 display resolution. 
 
View – Display 1024 x 768 
Resize application window to fit on a 1024 x 768 display resolution. Layouts 
created at a higher display resolution may not fit on a lower display resolution. 
 
View – Display 1280 x 960 
Resize application window to fit on a 1280 x 960 display resolution. Layouts 
created at a higher display resolution may not fit on a lower display resolution. 
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Edit – Layout (Ctrl+L) 
Switches to Layout Edit mode. In layout mode, all LEDs are displayed in their 
“Off” color. The Frame slider and all frame editing buttons are disabled. The 
current edit mode is displayed in the status bar. 

 
 
Edit – Animation (Ctrl+N) 
Switches to Animation Edit mode. In animation mode, LEDs are displayed with a 
solid fill for the “On” state and a diagonal line fill for the “Off” state. The current 
edit mode is displayed in the status bar.  

 
 
Edit – Undo (Ctrl+Z) 
Undo most recent edit in Animation mode. All animation edits including imports 
and fades can be undone. The editor buffers the last 50 animation edits. Undo is 
not available in Layout mode. 
 
Edit – Redo (Ctrl+Alt+Z) 
Redo previous undone edit in Animation mode. The editor buffers the last 50 
animation edits. Redo is not available in Layout mode. 
 
Edit – Snap To Grid 
Use Snap To Grid to easily align the LEDs when arranging your virtual control 
panel in layout editing mode. 
 
Edit – Select All LEDs (Ctrl+A) 
Selects all LEDs on the virtual control panel. When an LED is selected, its border 
is bold. 
 
Edit – Deselect All LEDs (Ctrl+D) 
Un-selects all LEDs on the virtual control panel.  
 
Edit – Selected LEDs – Toggle LEDs On/Off 
All selected LEDs in the “On” state are turned “Off” and all selected LEDs in the 
“Off” state are turned “On”. 
 
Edit – Selected LEDs – Set LEDs Color/Intensity Current Frame 
All selected Single Type LEDs in the current frame have their intensity set to the 
value of the Intensity Slider. All selected RGB Type LEDs in the current frame 
have their color set to the values of the Red, Green, and Blue Color Sliders (the 
color in the Color Sample Box). 
 
Edit – Selected LEDs – Set LEDs Color/Intensity Frames To End 
All selected Single Type LEDs from the current frame to the last frame have their 
intensity set to the value of the Intensity Slider. All selected RGB Type LEDs from 
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the current frame to the last frame have their color set to the values of the Red, 
Green, and Blue Color Sliders (the color in the Color Sample Box). 
 
Edit – Selected LEDs – Set LEDs Color/Intensity All Frames 
All selected Single Type LEDs in all frames have their intensity set to the value of 
the Intensity Slider. All selected RGB Type LEDs in all frames have their color set 
to the values of the Red, Green, and Blue Color Sliders (the color in the Color 
Sample Box). 
 
Edit – Selected LEDs – Copy LED Frames To End (Ctrl+C) 
Copy the color/intensity for a single selected LED from the current frame to the 
last frame. The status bar will indicate which frames were copied. 
 
Edit – Selected LEDs – Copy LED Frames Wrap 
Copy the color/intensity for a single selected LED for all frames starting from the 
current frame and ending with the frame prior to the current. The status bar will 
indicate which frames were copied. 
 
Edit – Selected LEDs – Paste LED Frames To End (Ctrl+V) 
Paste the color/intensity values (from a prior Copy action) onto a single selected 
LED from the current frame to the last frame. If the copy buffer has fewer frames 
than required, the remaining frames will not be pasted. If the copy buffer has 
more frames than required, not all from the buffer will be used. The selected LED 
must be the same type (Single or RGB) as the LED that was copied. Pasting will 
overwrite the color/intensity value of the selected LED. The paste buffer can be 
used multiple times. The status bar will indicate which frames were pasted. 
 
Edit – Selected LEDs – Paste LED Frames Extend (Ctrl+Alt+V) 
Paste the color/intensity values (from a prior Copy action) onto a single selected 
LED from the current frame for as many frames as the copy buffer currently 
holds. If the copy buffer has fewer frames than required, the remaining frames 
will not be pasted. If the copy buffer has more frames than required, the 
animation will be extended. The selected LED must be the same type (Single or 
RGB) as the LED that was copied. Pasting will overwrite the color/intensity value 
of the selected LED. The paste buffer can be used multiple times. The status bar 
will indicate which frames were pasted. 
 
Edit – Selected LEDs – Paste LED Frames Wrap 
Paste the color/intensity values (from a prior Copy action) onto a single selected 
LED from the current frame, ending with the frame prior to the current. If the copy 
buffer has fewer frames than required, the remaining frames will not be pasted. If 
the copy buffer has more frames than required, not all from the buffer will be 
used. The selected LED must be the same type (Single or RGB) as the LED that 
was copied. Pasting will overwrite the color/intensity value of the selected LED. 
The paste buffer can be used multiple times. The status bar will indicate which 
frames were pasted. 
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Edit – Turn On All LEDs 
Changes the state of all LEDs to “On”. See Default On Behavior. 
 
Edit – Turn Off All LEDs 
Changes the state of all LEDs to “Off”.  
 
Edit – Fade Up… (Ctrl+U) 
Generates a fade up effect across selected (or all) buttons. Both single and RGB 
type LEDs can be faded from a starting intensity to an end intensity. Alternately, 
the current button intensity can be used for start or end. The new frames required 
for the fade will be inserted or overlaid into the current animation. If you wish to 
fade specific buttons, remember to select them prior to displaying the Fade 
dialog.  See below for a full description of the Fade Up effect. 
 
Edit – Fade Down… (Ctrl+J) 
Generates a fade down effect across selected (or all) buttons. Both single and 
RGB type LEDs can be faded from a starting intensity to an end intensity. 
Alternately, the current button intensity can be used for start or end. The new 
frames required for the fade will be inserted or overlaid into the current 
animation. If you wish to fade specific buttons, remember to select them prior to 
displaying the Fade dialog.  See below for a full description of the Fade Down 
effect. 
 
Edit – Color Transition… (Ctrl+T) 
Generates a color transition effect across selected RGB buttons. The button 
color can be transitioned from a starting color to an end color. Alternately, the 
current button color can be used for the start or end. The new frames required for 
the color transition will be inserted or overlaid into the current animation. See 
below for a full description of the Color Transition effect. 
 
Edit – Set Duration For All Frames 
Displays a dialog to enter a frame duration time (in milliseconds) which is applied 
to all frames. The current duration values will be overwritten. 
 
Show Last Copy/Paste 
Display the source LED and frames from the last copy operation and the 
destination LED and frames from the last paste operation (if any). 
 
Run – Run LED Animation/Stop 
Run or Stop the current animation in real-time on your control panel. The 
animation will start from the current frame. This feature can be used to visually 
test how an animation will look when run by the LEDBlinky application. The Run 
LED Animation/Stop menu option is only enabled in animation edit mode. The 
Run LED Animation/Stop menu option is not available if you do not have any 
LED controllers connected to your pc. 
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Run – Run Virtual Animation/Stop 
Run or Stop the current animation in simulated-time on your virtual control panel. 
The animation will start from the current frame. The virtual control panel 
animation timing may not be as accurate as the LED Animation due to hardware 
and software variances. This feature is useful for testing without any actual LED 
controllers connected. The Run Virtual Animation/Stop menu option is only 
enabled in animation edit mode.  
 
Help 
Displays this document. 
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LED Pop-up Menus 

 
Set LED Off Color 
In layout mode, right-click on an LED to set the “Off” color from the Color Sample 
Box. The LED Off colors can be set so that your virtual control panel better 
represents your actual control panel. For example, Electric Ice Buttons are pearl 
white when not lit (off). 
 
Set LED Size – Small/Medium/Large 
In layout mode, right-click on an LED to set the LED size. The LED sizes can be 
set so that your virtual control panel better represents your actual control panel. 
 
Toggle LED On/Off 
In animation mode, right-click on an LED to toggle the state from “On” to “Off” or 
“Off” to “On”. See Default On Behavior. 
 
Get LED Color/Intensity 
In animation mode, right-click on an LED to set the Color and Intensity sliders to 
the value(s) from the LED. In effect, you are copying the LED color/intensity to 
the Color Sample Box. Get and Set LED Color/Intensity can be used as a copy 
and paste function. 
 
Set LED Color/Intensity Current Frame 
In animation mode, right-click on an LED to set in the current frame the LED’s 
color/intensity to the value(s) of the color and intensity sliders (Color Sample 
Box).  
 
Set LED Color/Intensity Frames To End 
In animation mode, right-click on an LED to set from the current frame to the last 
frame the LED’s color/intensity to the value(s) of the color and intensity sliders 
(Color Sample Box).  
 
Set LED Color/Intensity All Frames 
In animation mode, right-click on an LED to set in all frames the LED’s 
color/intensity to the value(s) of the color and intensity sliders (Color Sample 
Box).  
 
Copy LED Frames To End (Ctrl+C) 
In animation mode, right-click on an LED to copy the color/intensity from the 
current frame to the last frame. The status bar will indicate which frames were 
copied. 
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Copy LED Frames Wrap 
In animation mode, right-click on an LED to copy the color/intensity for all frames 
starting from the current frame and ending with the frame prior to the current. The 
status bar will indicate which frames were copied. 
 
Paste LED Frames To End (Ctrl+V) 
In animation mode, right-click on an LED to paste the color/intensity values (from 
a prior Copy action) from the current frame to the last frame. If the copy buffer 
has fewer frames than required, the remaining frames will not be pasted. If the 
copy buffer has more frames than required, not all from the buffer will be used. 
The selected LED must be the same type (Single or RGB) as the LED that was 
copied. Pasting will overwrite the color/intensity value of the selected LED. The 
paste buffer can be used multiple times. The status bar will indicate which frames 
were pasted. 
 
Paste LED Frames Extend (Ctrl+Alt+V) 
In animation mode, right-click on an LED to paste the color/intensity values (from 
a prior Copy action) from the current frame for as many frames as the copy buffer 
currently holds. If the copy buffer has fewer frames than required, the remaining 
frames will not be pasted. If the copy buffer has more frames than required, the 
animation will be extended. The selected LED must be the same type (Single or 
RGB) as the LED that was copied. Pasting will overwrite the color/intensity value 
of the selected LED. The paste buffer can be used multiple times. The status bar 
will indicate which frames were pasted. 
 
Paste LED Frames Wrap 
In animation mode, right-click on an LED to paste the color/intensity values (from 
a prior Copy action) from the current frame, ending with the frame prior to the 
current. If the copy buffer has fewer frames than required, the remaining frames 
will not be pasted. If the copy buffer has more frames than required, not all from 
the buffer will be used. The selected LED must be the same type (Single or RGB) 
as the LED that was copied. Pasting will overwrite the color/intensity value of the 
selected LED. The paste buffer can be used multiple times. The status bar will 
indicate which frames were pasted. 
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Color / Intensity Controls 

 
 
Red / Green / Blue Sliders 
Adjust the Red, Green, and Blue slider controls to set the color of the Color 
Sample Box. If any RGB Type LEDs are selected, changing the R/G/B sliders will 
also update then LED colors. R/G/B slider values range from 0 to 48.  
 
Intensity Slider 
Adjust the Intensity slider control to set the intensity of the Color Sample Box. If 
any Single Type LEDs are selected, changing the Intensity slider will also update 
the LED intensities. The intensity value ranges from 0 to 48. 
 
A note on LED Brightness: The intensity of an LED can also be considered its 
brightness value. Increasing or decreasing the intensity value will also affect the 
red, green, and blue values and vise versa – they are all linked. The intensity 
value cannot be greater than the maximum of the R/G/B values. So if you set the 
color to “orange”, and then move the Intensity slider, the Red, Green, and Blue 
slider controls will move in sync to increase or decrease the “orange” brightness. 
Low intensities on the virtual LEDs tend toward “black” and are not easily 
distinguishable. 
 
Color Sample Box 
The Color Sample Box represents the color set by the Red, Green, and Blue 
slider controls. Click on the Color Sample Box to set the color/intensity values for 
all selected LEDs. 
 
Pick Color Button 
Displays a color dialog to select from a standard color palette. After a color has 
been selected, R/G/B and Intensity slider values will be updated and all selected 
LEDs will be assigned the color/intensity values. 
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Frame Navigation Controls 

 
 
First Frame  
Jump to the first frame in the animation. 
 
Previous Goto/Repeat Frame  
Jump to the previous frame with goto/repeat values. 
 
Previous Frame  
Move one frame back in the animation. 
 
Next Frame  
Move one frame forward in the animation. 
 
Next Goto/Repeat Frame  
Jump to the next frame with goto/repeat values. 
 
Last Frame  
Jump to the last frame in the animation. 
 
Run LED Animation  
Run or Stop the current animation in real-time on your control panel. The 
animation will start from the current frame. This feature can be used to visually 
test how an animation will look when run by the LEDBlinky application. The Run 
LED Animation/Stop menu option is only enabled in animation edit mode. The 
Run LED Animation/Stop menu option is not available if you do not have any 
LED controllers connected to your pc. 
 
Run Virtual Animation  
Run or Stop the current animation in simulated-time on your virtual control panel. 
The animation will start from the current frame. The virtual control panel 
animation timing may not be as accurate as the LED Animation due to hardware 
and software variances. This feature is useful for testing without any actual LED 
controllers connected. The Run Virtual Animation/Stop menu option is only 
enabled in animation edit mode.  
 
Frame Slider 
Use the Frame slider control to switch between frames. The slider can also be 
used to simulate the animation. 
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Frame Editing Controls 

 
 
Add Frame Button 
Click the Add Frame button to add a new frame to the end of the animation. The 
new frame will inherit the intensity and on/off values from the prior frame. 
 
Insert Frame Button 
Click the Insert Frame button to add a new frame after the current frame. The 
new frame will inherit the intensity and on/off values from the prior frame. 
 
Move Frame Left << 
Click the Move Frame Left button to shift the current frame one position to the 
left. Note: If the current frame has a Goto value and moving the frame to the left 
places it before the goto frame value, then the goto value will be removed. 
 
Move Frame Right >> 
Click the Move Frame Right button to shift the current frame one position to the 
right.  
 
Delete Frame Button 
Click the Delete Frame button to delete the current frame. 
 
Frame Duration 
Enter the Frame Duration in milliseconds (1000 milliseconds = 1 second). 
 
Goto Frame 
The Goto and Repeat fields can be used to repeat a group of frames. The Goto 
frame value is always prior to the current frame. Multiple Goto groups can be 
defined in the animation, but groups should not overlap. 
 
Repeat 
Enter the number of times to repeat the frame group. 
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Fade Up/Down Controls 

 
 
Fade All / Fade Selected 
Select which buttons to fade, All or currently Selected. If you wish to fade 
selected buttons, they must be selected prior to displaying the Fade dialog. 
 
Overlay Existing Frames 
The Fade effect generates as many as 48 new frames. Normally the new frames 
will be inserted into the animation after the current frame. Optionally you may 
wish to overlay the new frames onto the animation starting with the current 
frame. Only the buttons participating in the fade will be overlaid – all other 
buttons will remain at their current intensity/color. 
 
The Overlay Existing Frames option is useful when you want to apply different 
fade effects at the same time in the animation. Select the button(s) for the first 
fade and insert the fade normally (without the overlay option). Then reset the 
current frame to the start of the fade, select the button(s) for the next fade effect 
and use the overlay option.  
 
Note: The Fade Duration for the overlay fade will overwrite the frame duration for 
the overlaid frames in the current animation.  All overlay fades must use the 
same Fade Duration. If an overlay fade requires frames beyond the end of the 
animation, the animation will be extended. 
 
Starting Intensity / Ending Intensity 
Specify the intensity to start the fade and the intensity to end the fade. 
 
Note: For RGB type buttons, when the Use Current option is not selected, the 
Color Sample Box will be used for the fade color. 
 
Use Current For Start / Use Current For End 
Optionally select to start or end the fade with the button’s current intensity. 
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Note: When fading multiple buttons with the Use Current option, each button may 
not require the same number of frames to complete its fade – the 
inserted/overlaid fade will use the maximum frames to complete the fade for all 
selected buttons. For RGB type buttons, when the Use Current option is not 
selected, the Color Sample Box will be used for the fade color. 
 
Fade Increment 
The Fade Increment defines the change in intensity/color between frames. 
Higher values may cause a choppy fade effect. Lower values will slow down the 
fade. A smooth fade requires a balance between the Fade Increment and the 
Fade Duration. 
 
Fade Duration 
The Fade Duration defines the frame duration used throughout the fade. The 
value is specified in milliseconds. Values smaller than 10ms may not have any 
noticeable effect on the speed of the animation. Higher values may cause a 
choppy fade effect. A smooth fade requires a balance between the Fade 
Increment and the Fade Duration. 
 
Note: When using the Overlay Existing Frames option, the Fade Duration will 
overwrite the frame duration for the overlaid frames in the current animation.   
 
Preset Fades 
Preset Fade settings are provided for slow, medium, and fast fades by setting the 
Fade Increment and Fade Duration to default values.  
 
You may also store and recall a custom fade setting. The Preset Fade Custom 
button recalls the Starting Intensity, Ending Intensity, Use Current For Start, Use 
Current For End, Fade Increment, and Fade Duration values as last stored using 
the Save As Custom button. 
 
Note: Depending on CPU and other performance issues, the Slow/Medium/Fast 
preset values may not provide desired results. 
  
Save As Custom 
The Save As Custom button stores the current Starting Intensity, Ending 
Intensity, Use Current For Start, Use Current For End, Fade Increment, and Fade 
Duration values. 
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Color Transition Controls 

  
 
Overlay Existing Frames 
The Color Transition effect generates as many as 48 new frames. Normally the 
new frames will be inserted into the animation after the current frame. Optionally 
you may wish to overlay the new frames onto the animation starting with the 
current frame. Only the buttons participating in the color transition will be overlaid 
– all other buttons will remain at their current color. 
 
The Overlay Existing Frames option is useful when you want to apply different 
color transition effects at the same time in the animation. Select the button(s) for 
the first color transition and insert the transition normally (without the overlay 
option). Then reset the current frame to the start of the color transition, select the 
button(s) for the next color transition effect and use the overlay option.  
 
Note: The Transition Duration for the overlay color transition will overwrite the 
frame duration for the overlaid frames in the current animation.  All overlay color 
transitions must use the same Transition Duration. If an overlay color transition 
requires frames beyond the end of the animation, the animation will be extended. 
 
Starting Color / Ending Color 
Specify the color to start the transition and the color to end the transition.  
 
To specify a custom color (not in the drop-down list), select the first item in the 
list – “custom…”. This will display the custom color dialog. Next, click on any one 
of the Basic Color boxes (you must do this – not sure why), then click the Define 
Custom Colors button. Define your custom color, then click the Add To Custom 
Colors button. Lastly, click your newly defined Custom Color box on the lower 
left, then click Ok. Your custom color will remain in the drop-down list until you 
define a new custom color or close the application. If you wish to retain the 
custom color for future use, store it as a Custom Preset Transition. 
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Use Current For Start / Use Current For End 
Optionally select to start or end the color transition with the button’s current color. 
 
Note: When color transitioning multiple buttons with the Use Current option, each 
button may not require the same number of frames to complete its transition – 
the inserted/overlaid color transition will use the maximum frames to complete 
the transition for all selected buttons.  
 
Transition Increment 
The Transition Increment defines the change in color between frames. Higher 
values may cause a choppy color transition effect. Lower values will slow down 
the transition. A smooth color transition requires a balance between the 
Transition Increment and the Transition Duration. 
 
Transition Duration 
The Transition Duration defines the frame duration used throughout the color 
transition. The value is specified in milliseconds. Values smaller than 10ms may 
not have any noticeable effect on the speed of the animation. Higher values may 
cause a choppy color transition effect. A smooth color transition requires a 
balance between the Transition Increment and the Transition Duration. 
 
Note: When using the Overlay Existing Frames option, the Transition Duration 
will overwrite the frame duration for the overlaid frames in the current animation.   
 
Preset Transitions 
Preset Transition settings are provided for slow, medium, and fast transitions by 
setting the Transition Increment and Transition Duration to default values.  
 
You may also store and recall a custom color transition setting. The Preset 
Transition Custom button recalls the Starting Color, Ending Color, Use Current 
For Start, Use Current For End, Transition Increment, and Transition Duration 
values as last stored using the Save As Custom button. 
 
Note: Depending on CPU and other performance issues, the Slow/Medium/Fast 
preset values may not provide desired results. 
 
Save As Custom 
The Save As Custom button stores the current Starting Color, Ending Color, Use 
Current For Start, Use Current For End, Transition Increment, and Transition 
Duration values. 
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Status Bar 

 
 
The first section on the Status Bar displays information on the selected LED. If 
multiple LEDs are selected, the total number is displayed. The most recent copy 
or paste action may also be displayed. 
 
The second section on the Status Bar displays the current Frame number and 
Total Frames. 
 
The third section on the Status Bar displays the edit mode; Layout or Animation. 
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Using Single Frame Animations 

LEDBlinky provides features to light your control panel LEDs based on the 
currently active buttons used by the front-end or the selected game. But what if 
you want to light some or all of the buttons independent from those that are 
active? That’s where the single frame animation can be useful. 
 
A single frame animation is not really an animation at all – with only one frame, 
nothing changes! But by assigning a single frame animation to an LEDBlinky 
event you will effectively set your own button layout. 
 
For example, you can create a single frame animation and assign it as the “FE 
Active” animation or the “Game Play” animation. Using LEDBlinky’s feature to 
assign game specific animations, you could theoretically create your own custom 
button layout for one or more selected game. 
 
Note: When a “Game Play” animation is used in conjunction with the “Light Game 
Controls” option, the active buttons will take precedence over the animated 
buttons. In this scenario, the single frame animation would only be used to light 
the inactive buttons. 
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Appendix A: Supported LED Controllers 

 
The LEDBlinky Configuration Help Menu has on option to display the list of 
supported LED Controller names and abbreviations. 
 
Groovy Game Gear LED-Wiz 
32 LED ports, variable intensity. 
 
Ultimarc PacDrive 
16 LED ports, on/off. 
 
Ultimarc U-HID 
16 LED ports, on/off 
 
Ultimarc PacLED64 
64 ports, variable intensity. 
 
Ultimarc iPac Ultimate I/O 
96 ports, variable intensity. 
 
Wolfware Tech Howler 
96 ports, variable intensity. 
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Appendix B: Menu Options For LED-Wiz Hardware Only 

 
Edit – Selected LEDs – LED-Wiz Build-in Blinking – Single – Ramp Up / Ramp 
Down 
All selected Single Type LEDs have their intensity set to the LED-Wiz built-in 
blinking effect. Ramp Up / Ramp Down sets the intensity value to 129. 
 
Edit – Selected LEDs – LED-Wiz Build-in Blinking – Single – On / Off 
All selected Single Type LEDs have their intensity set to the LED-Wiz built-in 
blinking effect. On/Off sets the intensity value to 130. 
 
Edit – Selected LEDs – LED-Wiz Build-in Blinking – Single – On / Ramp Down 
All selected Single Type LEDs have their intensity set to the LED-Wiz built-in 
blinking effect. On / Ramp Down sets the intensity value to 131. 
 
Edit – Selected LEDs – LED-Wiz Build-in Blinking – Single – Ramp Up / On 
All selected Single Type LEDs have their intensity set to the LED-Wiz built-in 
blinking effect. Ramp Up / On sets the intensity value to 132. 
 
Edit – Selected LEDs – LED-Wiz Build-in Blinking – Red – Ramp Up / Ramp 
Down 
All selected RGB Type LEDs have their Red intensity set to the LED-Wiz built-in 
blinking effect. Ramp Up / Ramp Down sets the intensity value to 129. 
 
Edit – Selected LEDs – LED-Wiz Build-in Blinking – Red – On / Off 
All selected RGB Type LEDs have their Red intensity set to the LED-Wiz built-in 
blinking effect. On/Off sets the intensity value to 130. 
 
Edit – Selected LEDs – LED-Wiz Build-in Blinking – Red – On / Ramp Down 
All selected RGB Type LEDs have their Red intensity set to the LED-Wiz built-in 
blinking effect. On / Ramp Down sets the intensity value to 131. 
 
Edit – Selected LEDs – LED-Wiz Build-in Blinking – Red – Ramp Up / On 
All selected RGB Type LEDs have their Red intensity set to the LED-Wiz built-in 
blinking effect. Ramp Up / On sets the intensity value to 132. 
 
Edit – Selected LEDs – LED-Wiz Build-in Blinking – Green – Ramp Up / Ramp 
Down 
All selected RGB Type LEDs have their Green intensity set to the LED-Wiz built-
in blinking effect. Ramp Up / Ramp Down sets the intensity value to 129. 
 
Edit – Selected LEDs – LED-Wiz Build-in Blinking – Green – On / Off 
All selected RGB Type LEDs have their Green intensity set to the LED-Wiz built-
in blinking effect. On/Off sets the intensity value to 130. 
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Edit – Selected LEDs – LED-Wiz Build-in Blinking – Green – On / Ramp Down 
All selected RGB Type LEDs have their Green intensity set to the LED-Wiz built-
in blinking effect. On / Ramp Down sets the intensity value to 131. 
 
Edit – Selected LEDs – LED-Wiz Build-in Blinking – Green – Ramp Up / On 
All selected RGB Type LEDs have their Green intensity set to the LED-Wiz built-
in blinking effect. Ramp Up / On sets the intensity value to 132. 
 
Edit – Selected LEDs – LED-Wiz Build-in Blinking – Blue – Ramp Up / Ramp 
Down 
All selected RGB Type LEDs have their Blue intensity set to the LED-Wiz built-in 
blinking effect. Ramp Up / Ramp Down sets the intensity value to 129. 
 
Edit – Selected LEDs – LED-Wiz Build-in Blinking – Blue – On / Off 
All selected RGB Type LEDs have their Blue intensity set to the LED-Wiz built-in 
blinking effect. On/Off sets the intensity value to 130. 
 
Edit – Selected LEDs – LED-Wiz Build-in Blinking – Blue – On / Ramp Down 
All selected RGB Type LEDs have their Blue intensity set to the LED-Wiz built-in 
blinking effect. On / Ramp Down sets the intensity value to 131. 
 
Edit – Selected LEDs – LED-Wiz Build-in Blinking – Blue – Ramp Up / On 
All selected RGB Type LEDs have their Blue intensity set to the LED-Wiz built-in 
blinking effect. Ramp Up / On sets the intensity value to 132. 
 
Edit – Selected LEDs – LED-Wiz Build-in Blinking – Set Frame Global Pulse 
Speed 
Set the LED-Wiz built-in blinking global pulse speed for the current frame. This 
applies to all LEDs (not just the selected LEDs). 
 
LED-Wiz Build-in Blinking – Single – Ramp Up / Ramp Down 
In animation mode, right-click on an LED to select from the LED-Wiz built-in 
blinking effects and set the Single Type LED intensity. Ramp Up / Ramp Down 
sets the intensity value to 129. 
 
LED-Wiz Build-in Blinking – Single – On / Off 
In animation mode, right-click on an LED to select from the LED-Wiz built-in 
blinking effects and set the Single Type LED intensity.  On/Off sets the intensity 
value to 130. 
 
LED-Wiz Build-in Blinking – Single – On / Ramp Down 
In animation mode, right-click on an LED to select from the LED-Wiz built-in 
blinking effects and set the Single Type LED intensity. On / Ramp Down sets the 
intensity value to 131. 
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LED-Wiz Build-in Blinking – Single – Ramp Up / On 
In animation mode, right-click on an LED to select from the LED-Wiz built-in 
blinking effects and set the Single Type LED intensity. Ramp Up / On sets the 
intensity value to 132. 
 
LED-Wiz Build-in Blinking – Red – Ramp Up / Ramp Down 
In animation mode, right-click on an LED to select from the LED-Wiz built-in 
blinking effects and set the RGB Type LED Red intensity. Ramp Up / Ramp 
Down sets the intensity value to 129. 
 
LED-Wiz Build-in Blinking – Red – On / Off 
In animation mode, right-click on an LED to select from the LED-Wiz built-in 
blinking effects and set the RGB Type LED Red intensity.  On/Off sets the 
intensity value to 130. 
 
LED-Wiz Build-in Blinking – Red – On / Ramp Down 
In animation mode, right-click on an LED to select from the LED-Wiz built-in 
blinking effects and set the RGB Type LED Red intensity. On / Ramp Down sets 
the intensity value to 131. 
 
LED-Wiz Build-in Blinking – Red – Ramp Up / On 
In animation mode, right-click on an LED to select from the LED-Wiz built-in 
blinking effects and set the RGB Type LED Red intensity. Ramp Up / On sets the 
intensity value to 132. 
 
LED-Wiz Build-in Blinking – Green – Ramp Up / Ramp Down 
In animation mode, right-click on an LED to select from the LED-Wiz built-in 
blinking effects and set the RGB Type LED Green intensity. Ramp Up / Ramp 
Down sets the intensity value to 129. 
 
LED-Wiz Build-in Blinking – Green – On / Off 
In animation mode, right-click on an LED to select from the LED-Wiz built-in 
blinking effects and set the RGB Type LED Green intensity.  On/Off sets the 
intensity value to 130. 
 
LED-Wiz Build-in Blinking – Green – On / Ramp Down 
In animation mode, right-click on an LED to select from the LED-Wiz built-in 
blinking effects and set the RGB Type LED Green intensity. On / Ramp Down 
sets the intensity value to 131. 
 
LED-Wiz Build-in Blinking – Green – Ramp Up / On 
In animation mode, right-click on an LED to select from the LED-Wiz built-in 
blinking effects and set the RGB Type LED Green intensity. Ramp Up / On sets 
the intensity value to 132. 
 



LEDBlinky Animation Editor Help Document 

 - 31 - 

LED-Wiz Build-in Blinking – Blue – Ramp Up / Ramp Down 
In animation mode, right-click on an LED to select from the LED-Wiz built-in 
blinking effects and set the RGB Type LED Blue intensity. Ramp Up / Ramp 
Down sets the intensity value to 129. 
 
LED-Wiz Build-in Blinking – Blue – On / Off 
In animation mode, right-click on an LED to select from the LED-Wiz built-in 
blinking effects and set the RGB Type LED Blue intensity.  On/Off sets the 
intensity value to 130. 
 
LED-Wiz Build-in Blinking – Blue – On / Ramp Down 
In animation mode, right-click on an LED to select from the LED-Wiz built-in 
blinking effects and set the RGB Type LED Blue intensity. On / Ramp Down sets 
the intensity value to 131. 
 
LED-Wiz Build-in Blinking – Blue – Ramp Up / On 
In animation mode, right-click on an LED to select from the LED-Wiz built-in 
blinking effects and set the RGB Type LED Blue intensity. Ramp Up / On sets the 
intensity value to 132. 
 
A note on the LED-Wiz built-in blinking effects: This feature of the LED-Wiz has 
little use with LED animations – the hardware controlled blinking cannot be 
synced between multiple LED controllers or with animation timing. This feature is 
not available for any other LED controller. 
 
LED-Wiz Build-in Blinking – Set Frame Global Pulse Speed 
Set the LED-Wiz built-in blinking global pulse speed for the current frame. This 
applies to all LEDs. 
 


